INSTRUCTION MANUAL

Orion® StarShoot™ Pro
Deep Space Color Imager
#52084

IN 336 Rev. A 7/08
Welcome to the exciting world of astro-imaging. Your new StarShoot™ Pro Deep Space Color Imaging camera is capable of capturing impressive celestial objects like galaxies, star clusters, and nebulae, as well as the planets, Moon, and the Sun (with an optional solar filter). You can showcase spectacular images on your computer, share them on the internet, or print them. The camera’s large 6 mega-pixel array enables full-sized 8"x10" prints, suitable for publishing.

Please read this instruction manual before attempting to use the camera or install the needed software. For the most detailed information on specific camera and software functions, consult the Maxim DL Essentials Help menu; the tutorials found there are especially useful for familiarizing yourself with the software and camera.

Table of Contents

1. Getting Started ........................................ 4
   Parts List ....................................... 4
   System Requirements ................................ 4
   Software and Driver Installation ..................... 7
   Getting Started During Daylight .................... 10
   Obtaining First Images ........................... 10
   Screen Stretch Window .......................... 13

2. Astronomical Imaging .................................. 14
   A Note about the TEC ............................ 14
   Focusing ...................................... 15
   Imaging Deep Sky Objects ........................ 17
   Dark Frames ................................... 18
   Flat Fields .................................... 19

3. Image Processing .................................... 21
   Dark Frame Calibration ........................... 21
   Flat Field Calibration ............................ 23
   Convert Raw to Color ............................ 23
   Combining Deep Sky Images ....................... 24
   Combine Methods ................................ 26

4. Using the StarShoot Pro as an Autoguider .......... 31
   Computer to Mount Connection .................... 33
   Autoguider Calibration ............................ 35
   Multiple Camera Control For Autoguiding ............ 37

5. Other Features of Maxim DL Essentials ............ 37
   Edit Menu ...................................... 37
   View Menu ..................................... 38
   Window Menu .................................. 38
   Help Menu ..................................... 39

6. Tips .................................................. 39
   Polar Alignment .................................. 39
   Choosing a Site for Astro-imaging .................. 40
   Using Focal Reducers and Barlow Lenses .......... 40
   Filters ......................................... 41
   USB Extension Cable ............................ 41
   Care and Maintenance ............................. 41

7. Specifications .................................... 42

Appendix A. Troubleshooting ......................... 43
Appendix B. Field of View Quick Reference Guide .. 46
Appendix C. Summarized Procedure to Imaging Deep Sky Objects ................................ 51
1. Getting Started

Parts List
- StarShoot Pro Deep Space Color Imager
- 10’ USB cable
- 12’ DC power cable with lighter plug
- CD-ROM
- Hard carrying case

System Requirements (refer to Figure 1)

Telescope
The StarShoot Pro can be used with most telescopes compatible with 2" format eyepieces. The camera is simply inserted into a focuser in the same way as a standard eyepiece (Figure 2a). The camera is also compatible with 1.25" focusers that include camera T-threads.

Caution: Be sure to always firmly tighten the thumbscrew(s) that secure the StarShoot Pro in the telescope focuser, or it could fall out and onto the ground!

If your telescope has T-threads for direct camera attachment, a more secure connection can be made. First, unthread the nosepiece from the SS Pro. This exposes the camera’s T-threads. Then, simply thread the camera onto your telescope (Figure 2b).

The camera requires approximately 0.7” (18mm) of inward focus travel relative to where a standard eyepiece focuses with your telescope. If your telescope does not have enough inward focus travel, you will need to use an optional 2” barlow lens to extend the telescope’s focal plane to the camera’s imaging plane. Some telescopes (such as refractors) may require the use of an extension tube (available from Orion) to provide enough outward focus for the StarShoot Pro.

The large 1.8” format imaging chip gives the StarShoot Pro an ample field of view through most telescopes. See “Appendix B. Field of View Quick Reference Guide” for a list of the field of view provided by several common telescopes. The camera’s pixel size and sensitivity make the StarShoot Pro suitable for most telescopes.

Because the StarShoot Pro uses a larger format CCD chip, a telescope with a 2” focuser is recommended to full field illumination. You can still use the camera with a 1.25” focuser if it has optional T-threads; however, some vignetting (edge-darkening) may occur in the images.
Deep sky imaging with the StarShoot Pro requires an equatorial mount with a right ascension (R.A.) motor drive. The goal for your mount is to seamlessly track the apparent movement of the sky as the Earth rotates. The tracking must be very accurate, or the object you want to image will drift and blur across the camera’s field of view while the exposure is taken. Even a small amount of drift will cause a star to look oblong instead of a round point. We recommend using a high-quality equatorial mount which utilizes periodic error correction (PEC) or has the ability to interface with an autoguider.

Computer
The StarShoot Pro requires a PC to operate the camera. For astro-imaging in the field at night, a laptop computer is highly recommended. The included software is Maxim DL Essentials which requires Windows XP, or Windows Vista operating systems.

Note: The StarShoot Pro drivers and Maxim DL Essentials do not support 64-bit operating systems

The following hardware is also required:

- Processor: 700 MHz speed or higher, Pentium™ III equivalent or higher
- Recommended minimum memory size is 512 MB
- Disk Space: 100 MB for program installation, 500 MB or more to store images is recommended

Power
The StarShoot Pro requires 12 volts DC (12VDC) with approximately 1 ampere of current. Power to the entire camera, including the thermo-electric cooler (TEC), and fan is supplied by the included power cable when plugged into a 12VDC power source (Figure 3).

Imaging in the field usually requires the use of a portable field battery to supply power, or you can use a 110VAC to 12VDC power converter if you have access to an AC outlet. Make sure the power supply provides at least 1 ampere of current.

Note: The StarShoot Pro can operate with as low as 8 volts in situations when your battery starts loosing power.

Software and Driver Installation
Before the camera can be used, the software and camera drivers must be installed onto your computer. Turn on your computer and allow the Windows operating system to load as normal. Insert the included CD-ROM into your computer’s CD-ROM drive, and the Launcher will appear. This allows you to install the Maxim DL Essentials software. After the software is installed, the drivers will install automatically once the StarShoot Pro is initially connected to the computer. Do not connect the camera to your computer before you have installed the software.

Software Installation
To install Maxim DL Essentials Edition:

1. Insert the CD-ROM into the drive. The Launcher will appear (Figure 4). (For Windows Vista computers, the AutoPlay window will appear first. Select Run Launcher.exe, then the Launcher will appear.)
2. Click Install.
3. The InstallShield Wizard will start. Click Next.
4. Read the Maxim DL License Agreement. If you agree with the terms, then select I accept the terms in this license agreement and click Next.
5. Click Install. The installation will proceed.
6. The installation is now complete. Click the Finish button.

You can start Maxim DL Essentials Edition using the desktop icon, or using the Windows Start menu.

Camera Driver Installation

Now that the software is installed, the camera driver must also be installed. The system will automatically guide you through driver installation when the StarShoot Pro is initially connected to the computer. You must connect power to the camera and connect the USB cable from your camera to the computer before starting Maxim DL Essentials Edition, or the software and computer will not recognize the camera.

To install the camera driver on a Windows XP computer:
1. Insert the CD-ROM into the computer.
2. Connect the Orion StarShoot Pro to a USB port on the computer with the supplied USB cable.
3. Plug the supplied power cable into a 12VDC power source and connect the cable to the StarShoot Pro. The cooling fan will automatically power on. Windows will automatically detect the camera and start the Found New Hardware Wizard (Figure 5a).

Note: The StarShoot Pro will not work with USB 1.1. Your computer must have a high-speed USB 2.0 port available.
4. Select No, not this time when Windows asks to automatically search for drivers online and click Next.
5. Select Install from a list or specific location (Advanced) and click Next.
6. Select Search removable media (floppy, CD-ROM...). Turn off the other options. Click Next.

Windows will start looking for the driver files on the CD-ROM.
7. Windows will note that the driver has not passed Windows Logo testing. This is normal. Click the Continue Anyway button.
8. Click the Finish button when the wizard has completed. A message will appear in your Windows task bar Device Installed Successfully.
9. Start the Maxim DL Essentials Edition software. The camera will automatically be recognized, and the Camera Control Window (Figure 6) will appear.

To install the camera driver on Windows Vista computer:
1. Insert the CD-ROM into the computer.
2. Connect the Orion StarShoot Pro to a USB port on the computer with the supplied USB cable.
3. Plug the supplied power cable into a 12VDC power source and connect the cable to the StarShoot Pro. The cooling fan will automatically power on. Windows will automatically detect the camera and display the Found New Hardware window (Figure 5b).
4. Select Locate and install driver software (recommended).
5. In the next window that appears, select Don’t search online.
6. The next window that appears will ask you to “Insert the disk that came with your StarShoot Camera”. Click Next.
7. A **Windows Security** window will appear and mention that “Windows can’t verify the publisher of this driver software”. Choose **Install this driver software anyway**.

8. When the window appears telling you “The software for this device has been successfully installed”, click **Close**. This completes the driver installation process.

9. Start Maxim DL Essentials. The camera should be automatically recognized, and the **Camera Control Window** (Figure 6) will appear. Once the driver is installed, the computer and software will recognize the StarShoot Pro whenever it is plugged in.

   **Note:** If your computer (Windows XP or Vista) has multiple USB ports, you will need to install the driver again if the StarShoot Pro is connected to a different USB port.

**Getting Started During Daylight**

We recommend using the StarShoot Pro for the first time during the day. This way, you can become familiar with the camera and its functions without having to stumble around in the dark. Setup your telescope and mount so the optical tube is pointing at an object that is at least a couple of hundred feet away. Insert an eyepiece and focus as you normally would.

Since the StarShoot Pro is so sensitive to light, you will need to “stop down” your telescope aperture to do any imaging in daylight. This can be done by creating a simple aperture mask out of a piece of cardboard. The piece of cardboard should be larger than the telescope’s aperture. Cut a circular hole in the cardboard approximately 1/2” in diameter, and place the cardboard over the front of the telescope so that it completely covers the aperture except for the 1/2” circle. If you are using a refractor telescope, then the hole should be cut so it is centered on the piece of cardboard. If you are using a reflector that has a central aperture obstruction, then the hole should be cut off to one side (in order to bypass the central obstruction). Affix your aperture mask to your telescope with tape (Figure 7).

**Obtaining First Images**

To obtain first images (in daylight) with the StarShoot Pro, follow these step-by-step instructions:

1. With an eyepiece inserted in the telescope, center and focus on an object approximately 1/4 mile away. If you cannot focus your telescope to an object this close due to lack of back-focus travel, then you will need to utilize an optional extension tube (available from Orion).

2. Plug the camera into your computer’s USB port.

3. Plug the power cable into the StarShoot Pro, with your 12VDC power source already connected. The cooling fan should automatically power on.

4. Open Maxim DL Essentials by clicking on the icon installed on your computer’s desktop. Once open, Essentials should automatically connect to your camera and display the **Camera Control Window**.

5. Remove the eyepiece from your telescope.

6. Connect the camera to your telescope. Make sure the securing thumbscrew(s) on the focuser drawtube is firmly tightened. If your telescope has built-in T-threads, then remove the nosepiece from the StarShoot Pro, and thread the camera onto the telescope (see Figures 2a-b).

7. Set the mode to **Light Color 1x1** in the **Camera Control Window**. Set the **Seconds** (exposure time) to .01 to begin with. In the box underneath the **Mode** box, select **Focus**. Make sure the **Dark Subtract** box is unchecked. Check the **Delay** box so you can easily stop the exposures when the camera is focused.

8. Press the **Expose** button in the **Camera Control Window**. The camera will take short exposures and display them on the computer screen. For daytime imaging, open the **Screen Stretch Window** (in the **View** menu), and set the stretch mode to **Moon**.

9. Try to get a **Max Pixel** of around 40000 to 50000 by increasing or decreasing exposure time (.002 sec is the minimum exposure time). If the (daytime) image is still too bright to produce an acceptable image on your computer...
screen, you may need to stop-down the aperture of your telescope further. Try making another aperture mask with a diameter of only 1/4”.

10. Turn the telescope’s focus knob so the focuser drawtube moves slowly inward. The drawtube needs to go approximately 18mm inward from where the eyepiece focuses (for most eyepieces). Look at the computer screen and adjust the focus knob accordingly to determine best image focus.

11. Adjust the image orientation, if needed, by rotating the camera within the focuser drawtube. Simply loosen the thumbscrew on the drawtube and rotate the camera until the desired image orientation is achieved. Retighten the thumbscrew on the focuser drawtube when done. You may need to slightly refocus (using the telescope’s focus knob) if the focuser drawtube has moved a bit inward or outward when the camera was rotated.

12. When the image is focused and the image looks acceptable, press the Stop button in the Camera Control Window.

13. Select Single in the pull-down menu underneath Mode in the Camera Control Window.

14. Click the Expose button in the Camera Control Window. An image will appear in a window.

15. Select Save from the File menu to save the image for processing later, if you wish.

You have captured your first image with the StarShoot Pro! This simple method of imaging is exactly how the camera could be used to capture terrestrial subjects during daylight hours. Close-up images of birds and other wildlife or faraway vistas can all be obtained in this way with the StarShoot Pro. Solar images can also be taken during the day with an optional full-aperture solar filter over the front of the telescope.

Take some time to use the camera and Maxim DL Essentials software during the day to become familiar and comfortable with their basic operation.

**Screen Stretch Window**

The function of the Screen Stretch Window (Figure 8) is to properly map the image brightness levels captured by the camera into corresponding image brightness levels on the computer screen. A typical camera image has each pixel (light detecting site, over six million pixels form a single StarShoot Pro image) represented as a number (from 1 to 65535) depending on brightness. This has to be mapped into the video monitor’s brightness range (from 1 to 255). It is important to set the screen stretch appropriately, or a great image may look terrible!

When an image is displayed, you will notice a graph in the Screen Stretch Window. This is called the “histogram” of the currently displayed image (Figure 9). A histogram is a simple bar graph that shows the range of brightness in an image. Each bar in the graph represents a level of brightness; the bar to the far left in the histogram represents the dimmest pixels, and the bar to the far right is for the brightest pixels. The height of the bar is the total number of pixels at that brightness level in the image. Every image has a different histogram depending on how much of the image is bright or dark. Directly viewing the histogram of your image in the Screen Stretch Window provides an easy interface for making decisions on how the screen stretch should be set.

In Maxim DL Essentials, the two parameters entered in the Screen Stretch Window are Minimum and Maximum. A pixel that is at the Minimum value is set to zero (black), and a pixel at the Maximum value is set to 255 (white). An easy way to adjust the Maximum and Minimum values is to move the slider arrows located directly under the histogram of the image in the Screen Stretch Window. The red slider arrow corresponds to the Minimum value and the green arrow corresponds to the Maximum value. Simply left-click and then drag each arrow to adjust it to the desired level. The best results are obtained by adjusting the arrows (numbers) until the most pleasing display appears.

There are also seven automatic settings in the Screen Stretch Window. Typically, Medium will give good results for deep sky objects, so the default screen stretch setting is Medium. Instead of using the Screen Stretch Window, it is faster to use the Quick Stretch facility. This allows you to modify the image appearance instantly with small up/down and left/right movements.
of the mouse. To do this, hold down the Shift key, then left-click and drag the mouse on the image. You’ll find this feature to be a great convenience when fine adjusting the screen stretch to get an image to look its best.

Instead of using the Screen Stretch Window, it is faster to use the Quick Stretch facility. This allows you to modify the image appearance instantly with small up/down and left/right movements of the mouse. To do this, hold down the Shift key, then left-click and drag the mouse on the image. You’ll find this feature to be a great convenience when fine adjusting the screen stretch to get an image to look its best.

The trick with stretching is determining exactly how to stretch the image for best effect. Often there are several different possibilities for the same image. Trial-and-error will be the best way to judge what the best screen stretch setting is. Try several different settings until you find one you think looks best. When the image is subsequently saved, the screen stretch setting information will be kept when the image is next opened. Feel free to adjust the Screen Stretch settings all you want; it will not effect the image data you captured and only effects how the image is displayed. You can always switch back to a preset setting, like Medium or Moon.

2. Astronomical Imaging

Now that you’re familiar with basic camera and software operation, it’s time to take the StarShoot Pro out at night under the stars to capture some astronomical images. We recommend starting with the Moon, as it is easy to acquire into the camera’s field of view, and typically does not require stacking multiple exposures like planetary and deep sky images do.

A Note about the TEC

One of the most advantageous features of the StarShoot Pro is the thermoelectric cooler (TEC). The TEC is automatically turned on when the camera is plugged into your computer and powered on with the 12VDC power source. The cooler is always on when the camera is powered on, providing the coolest possible CCD temperature.

The TEC is like a refrigerator in the camera. When the camera is running, it produces internal heat which causes “noise” in images. The TEC counteracts this by cooling the CCD chip, which reduces thermal noise. This produces better quality images than cameras without coolers can provide. Also, cameras with simple air-cooling (i.e. with an onboard fan or heat sink only) cannot reduce the internal camera temperature below ambient (outside) temperature, and therefore produce images that are inherently inferior. The TEC in the StarShoot Pro, with the added help of the cooling fan, will reduce the temperature of the camera’s interior to approximately 54°F (30° C) below the ambient outside temperature.

Focusing

Focusing the CCD camera is one of the most critical parts of imaging. It can be challenging, but MaxIm DL Essentials has some helpful features which will assist you when focusing your StarShoot Pro. Before focusing, make sure your mount is polar aligned and tracking.

For best results, we recommend focusing on a star at least 30º above the horizon (or higher). Follow these steps to achieve an accurate focus:

1. Find and center a moderately bright star through your finder scope. Try to find a star around magnitude 4 or 5. If you are not using an optical finder or just using your unaided eye, the star should look relatively faint. This is important because brighter stars will easily over saturate the camera and compromise the focus accuracy.

2. Center your telescope on the star using an eyepiece. Make sure the right ascension (R.A.) tracking motor is engaged on your mount.

3. Replace the eyepiece with the StarShoot Pro.

4. Set the Mode to in the Camera Control Window to Light Color 1x1. Set Seconds (exposure time) to 1 second to begin with. In the box below the Mode box, select Single.

5. Click the Expose button. You should see the out of focus star in the image. If you do not see anything, you need to increase the exposure time.

6. Check that the Subframe section at the bottom of the Camera Control window has both the On and Mouse boxes checked on.

7. Draw a small box around the unfocused star with your mouse (hold-click and drag the mouse cursor around the star to draw the box, Figure 10).
8. In the Camera Control Window, in the box below the Mode box, select Focus. Click Expose. The camera will only download the area you previously selected, which makes each image download significantly faster than the whole frame.

Note: If the StarShoot Pro is grossly out of focus, no object will appear in the image, not even a blur. Increase the exposure time if needed and patiently move through the focus range of your telescope until you see the centered star come into view.

9. Gradually adjust the telescope’s focuser inward until the star visually comes to a small point on your computer screen. You have achieved a rough focus. Some small adjustments remain to get a perfect focus.

10. Click the Stop button.

11. Set Seconds somewhere between 0.002 and 0.1 seconds (or longer for fainter stars).

12. Click Expose.

13. Carefully watch the FWHM and Max Pixel values in the Camera Control Window (Figure 11). The FWHM (Full-Width Half Maximum) indicates the diameter of the star. The Max Val is the brightness value for the brightest pixel in the star. The smaller the FWHM, and the larger the Max Pixel, the closer you are to focused.

14. Adjust the focus as needed to get the smallest FWHM and largest Max Pixel possible. The Max Pixel should stay well below 65535, as this is the saturation level for the camera. If the Max Pixel approaches 65535, reduce the exposure time or try selecting a fainter star. Paying attention to these values will help you get a very accurate focus, far better than simply looking at the star image on your screen.

15. Click Stop once you reach the best focus and click Reset in the Subframe section at the bottom of the Camera Control window (Figure 12). Before proceeding to take images, set the Mode box back to Single.

Note: Due to atmospheric seeing conditions, you may notice significant fluctuation in the FWHM and Max Pixel values while focusing. You typically have to take multiple exposures each time you adjust the focuser to determine the quality of your focus.

Caution: Once you have achieved focus, be sure to click the Reset button at the bottom of the camera control window, otherwise the camera will crop all your images into a small square!

Imaging Deep Sky Objects

Capturing impressive images of deep sky objects, such as galaxies, nebulae, and star clusters, require long exposures. You will take several individual images and stack them together to form one high-quality resultant image, just as you would with planetary imaging. But while planetary images are formed by stacking many exposures of less than 5 seconds, deep space images will generally be comprised of individual images of a minute or longer!

Note that the StarShoot Pro is also capable of capturing planetary images. To increase the image scale of the planets, a barlow lens is recommended. See “Tips – Using Focal Reducers and Barlow Lenses”.

Very accurate polar alignment is essential for deep sky imaging. Stars will streak across the field of view without precise polar alignment and tracking. Longer exposures of 60 seconds or more also require autoguiding with a separate camera. The Orion StarShoot AutoGuider can be operated with the StarShoot Pro in MaxIm DL Essentials.

To start:

1. Acquire and center the deep sky object into the field of view of your eyepiece. If you are using a mount with an accurate computerized go-to system, you can keep the camera installed in your telescope’s focuser without using the eyepiece.

2. Remove the eyepiece and replace it with the StarShoot Pro.

3. Set the Mode to Light Color 1x1 and precisely focus the camera by using the telescope’s focus knob and the Focus setting in the Camera Control Window. If necessary, move the telescope to a nearby star to determine the best focus. (Refer to “Focusing”)

4. For best results, set the Mode to Light Raw 1x1 after you have reached focus. Use the Medium setting in the Screen Stretch Window.
5. Select **Single** in the box under the **Mode** box and take a 10-20 **Second** exposure of the deep sky object to ensure it is centered well in your camera. Adjust the camera orientation if needed, keeping in mind that you may have to refocus the camera after making the adjustment. Reposition the telescope if needed to center the deep sky object.

6. Select **AutoSave** in the box under the **Mode** box in the **Camera Control Window**. Set the number of images you would like the camera to take under **Autosave** (start with 5 or so), select the file folder in which you would like to save the images with **Folder**, and enter in a **Base filename** for the captured images. Typically the name of the object being imaged, such as “OrionNebula1”, will be entered here. If “OrionNebula1” is the **Base filename**, and you choose to **Autosave** five images, then the images will appear in the selected file folder as “OrionNebula1_0001.fit”, “OrionNebula1_0002.fit”, “OrionNebula1_0003.fit”, “OrionNebula1_0004.fit”, and “OrionNebula1_0005.fit”. Try exposures of 30 **Seconds** to start.

7. Click **Expose**, and the camera will commence taking the images.

*Note: When the camera is taking long exposure images, it is critically important not to touch, shake, or otherwise disturb the telescope, or a blurred image will result. Also, make sure no surrounding light shines into the telescope during the exposure.*

**Dark Frames**

Dark frames are images taken with no light coming into the camera. A dark frame is typically taken with the telescope’s objective capped. The only data in the image is the inherent camera noise (Figure 13). The noise contains the dark current (background noise level), read noise (noise introduced during camera readout and download) and hot pixels (bright dots in the image). All of this noise exists in your raw astro-image too, which distracts from the detail you want to see.

To eliminate most of the camera noise, you can take several dark frames, average them, then subtract them from your astro-images, also called, “light” images.

As the outside temperature changes, so does the camera temperature and noise levels. So the dark frames must be taken close to the same time your light images are taken, so that the camera temperature is nearly the same. So if you take 5 light images, you should take a couple of darks right before or after the light images.

To take dark frames for subtraction from “light” images:

1. Set the **Mode** in the **Camera Control Window** to **Dark Raw** 1x1.

2. Use the same exposure time as the “light” images you have or will take.
   
   If your “light” image is 60 seconds, the dark frame must also be 60 seconds.

3. Choose **Autosave** in the box beneath the **Mode** box.

4. Set the number of dark frames you would like the camera to take under Autosave (3 to 10 will generally suffice, as these will be averaged together)

5. Select the file folder in which you would like to save the dark frames with **Folder**, and enter in a **Basefilename** for the captured dark frames. Typically the name of the object being imaged with the word “dark” added, such as “OrionNebula1dark”, will be entered here. If “OrionNebula1dark” is the **Base filename**, and you choose to **Autosave** five images, then the images will appear in the selected file folder as “OrionNebula1dark_0001.fit”, “OrionNebula1dark_0002.fit”, “OrionNebula1dark_0003.fit”, “OrionNebula1dark_0004.fit”, and “OrionNebula1dark_0005.fit”. Using the word “dark” in the **Base filename** will help you distinguish between light and dark frames when combining later.

6. Click **Expose**, and Maxim DL Essentials will indicate the camera needs to be covered to take a dark frame. Cover the front of the telescope you are imaging through, and then click **OK**. The camera will commence taking and saving the dark frames. You will calibrate your images with these dark frames later see “Dark Frame Calibration”.

**Flat Fields**

A flat field is an image taken with uniform featureless light entering the telescope, such as a blue sky in the early morning or after sunset. Flat fields solve a number of issues in your astro-images.
Vignetting
Vignetting (Figure 14a) in a telescope reveals edge-darkening in the astro-image. The large CCD chip in the StarShoot Pro can easily detect vignetting through almost any telescope, even specialized astrographs. Vignetting is more apparent when the telescope's illuminated field is not large enough to illuminate the full area of the CCD chip. As a result, more light is detected in the center of the image compared to the edge.

Dust and Particles
Dust and particles (Figure 14b) will inevitably show up in your raw astro-images. Large particles on the CCD optical window sometimes look like unfocused circles or doughnuts in your images. It's too late to clean your camera if you are already imaging in the field at night. And even when the camera is clean, dust usually finds a way to show up in your images.

Telescope Artifacts
Very large particles or other artifacts in your telescope can effect your astro images. Insufficient telescope baffling or poor collimation can also cause unsymmetrical field illumination in your images.

To take a flat field image:
1. Ensure that the telescope is focused and ready for astro-imaging.
2. Point the telescope at a uniform and featureless light source, like the sky at dusk or dawn, or a blank white sheet of paper. Make sure the camera orientation is exactly the same as it is or was for astro-imaging (Although the telescope is pointing at a featureless surface, the focus and orientation must be set as it normally would be for astro-images.)
3. Set the Mode in the Camera Control window to Light Raw 1x1.

4. Select Single in the box beneath Mode.
5. Set the Seconds to 0.1 for now and click Expose. You want the Max Pixel to read somewhere around 20000. Adjust the exposure time as needed until the Max Pixel is close to 20000.
6. Select Autosave (5-10 images) in the box beneath Mode.
7. Choose a file name to save your flat fields. You should include “flat” in the file name to easily find it later, e.g. “OrionNebulaFlat”.

The flat fields also need dark frames.
8. Set the Mode in the Camera Control window to Dark Raw 1x1.
9. Rename the Autosave file to include “darkflat” so you can easily find the file later when calibrating.
10. Use the same exposure time as your flat field and click Expose.

Light and Dark 2x2 Modes
For added convenience and versatility, the StarShoot Pro's individual pixels (light-detecting sites) can be “binned” into units of two-by-two pixels (i.e. four individual pixels create one binned 2x2 pixel). This creates larger and more sensitive pixels, but with decreased resolution. This can be useful for some types of astronomical imaging, such as capturing faint nebulae. It can also be useful for quickly checking the image centering and orientation before using the normal Light Raw 1x1 mode to actually capture images. To use in “2x2” mode, select Light Mono 2x2 mode for capturing “light” images, and Dark Mono 2x2 mode to capture dark frames for averaging and subtracting. Images can be combined and processed in the same way as Light Raw 1x1 images.

By binning the images in 2x2, you will bypass the RGB filter built into the camera; so the resulting binned images will be black and white, without the ability to convert to color.

3. Image Processing
After all your image data is captured, you are ready to process your images to a final resultant image. All of your light images, dark frames, and flat fields must be processed to create your final astro-image. MaxIm DL Essentials also contains additional image processing functions (in the Process menu) to further enhance your astro-image.

Dark Frame Calibration
The dark frames you previously saved will be subtracted from your “light” images.
1. Select Setup Calibrate from the Process menu.
2. Click Remove All if any filenames appear in the window.
3. Click **Add** under the **Dark Frames** box in the **Setup Calibration** window (Figure 15) and select the file folder location for the dark frames taken. Select the dark frames and click **Open**. The selected dark frames will now appear in the pop-up window.

4. Click **OK**. The dark frames have now been averaged and stored into memory.

**Calibration Tip:** If you took your dark frames before your light images, you can subtract the darks from each light image as you capture it. Simply check the **Calibrate** box in the **Camera Control** window. However, for best results, we recommend manually subtracting the dark frames from each light image to make sure the calibration worked properly. If, for example, your telescope had a light leak when the dark frames were taken, it could ruin your light images. But if you subtract the dark frames AFTER the light frame is taken, you ensure keeping your raw astro-images in tact.

5. Select **Calibrate** from the **Process** menu (or click the **Calibrate** icon in MaxIm DL Essentials) and the dark frames will be subtracted from the light image. You should see a significant amount of noise disappear.

This process can be automated for all of your light images, see “Batch Processing”.

**Flat Field Calibration**

Calibrating your flat field images is done in the same way as calibrating your dark frames, but you also need to subtract dark frames for your flat field images.

To flat field calibrate:

1. Select **Setup Calibrate** in the **Process** menu.
2. Click **Add** under the **Flat-Field Frames** box in the **Setup Calibration** window and select the file folder location for the flat field images taken. Select the flat field files and click **Open**. The selected flat field files will now appear in the pop-up window (Figure 15).
3. Click **Add** under the **Darks for Flats** box in the **Setup Calibration** window and select the file folder location for the flat field dark frames taken. This is why it’s very important to label your autosaved images.
4. Select **Calibrate** from the **Process** menu and the flats will be calibrated.

If you have taken darks and flats, you can calibrate all of them at the same time (Figure 15).

**Convert Raw to Color**

Once you have calibrated your images, you need to convert them to color:

1. Open the raw images you wish to convert to color. If you need to convert more than 5 images or so, please refer to “Batch Processing” as this method allows you to combine an unlimited number of images without consuming more memory from your computer.
2. Select **Convert Raw to Color** in the **Process** menu.
3. Select **StarShoot Pro High Quality** in the **Camera Type** pull down menu (Figure 16).
4. Click **OK** and the image should appear in color. You can make several adjustments to the Color Balance if needed (see “Color Balance”).

---

**Figure 15.** Use the **Setup Calibration** window to select the dark frames and flat fields you want to calibrate from your “light” images.

**Figure 16.** The **Convert Raw to Color** window converts your raw StarShoot Pro images to RGB color.
Combining Deep Sky Images

Each individual deep sky image is faint and has a noticeable amount of noise. Combining the individual deep sky images eliminates the noise and enhances the detail in the deep sky object by improving the signal to noise ratio. The more images you combine, the better the resulting image will look. (Figure 17a and Figure 17b).

Now that you have multiple images of the deep sky object, you will combine the images to form one high-quality resultant image. To do this:

1. Select Open from the File menu. Find the folder you indicated with Folder, open it, and select all images for stacking using the mouse left-click and the Shift key. All of the individual images selected will open in Maxim DL Essentials.

Note: If you are combining more than 5 images, please refer to “Image Processing – Batch Processing” as this method allows you to combine an unlimited number of images without consuming more memory from your computer.

2. Select Combine in the Process menu.

3. In the Select Images window, click Add All. Then click OK.

4. The Combine Images window will appear (Figure 18). For Align Mode, choose Manual 1 star – shift only. (If you have field rotation due to a poor polar alignment or if you are using a motorized altitude-azimuth mount, then you can use the Manual 2 stars align mode.) In the Output box, select Average. Make sure the Use Centroid and Auto Next boxes are checked.

5. Find a well-shaped (circular) star in the first image displayed. Use the mouse to center the crosshairs on the selected star and left-click.

Note: In addition to Average mentioned above, 3 other different combining methods can be chosen: Sum, Median, and Sigma-Clip. To learn more about these combine methods, see “Image Processing – Combine Methods”.

The program automatically moves to the next image.

6. Center the crosshairs on the same star in this new image, and left-click again. Repeat this for all the open images; a chime will sound when you have gone through all the open images. (If you use the Manual 2 stars align mode, then select another alignment star in the first image displayed after you hear the chime).

7. If you find an image that looks poor, you can reject it by clicking the Reject Image button. Use the Next Image (and/or Previous Image) button to continue going through the open images after an image is rejected.

8. At least one image must be used as the reference image for the stacked images to be overlaid upon. The default uses the first image for the reference image. If you reject the first image or otherwise want to use another image as the reference, click the Set As Reference button. If the image currently chosen as the reference is rejected from the stack, you will not be able to Overlay All Images.

8. Now, click the Overlay All Images button. All of the selected images will stack on top of each other to form one resultant image. Click OK.
Set the **Screen Stretch Window** to **Medium** (or otherwise manually adjust for best image appearance), and use **Save** under the **File** menu to save your image. You can now perform any wanted imaging processing.

**Combine Methods**

We previously mentioned in “Imaging Deep Sky Objects” that **Average** is one of the methods to combine your images. There are three other methods that will achieve slightly different results: **Sum**, **Median**, and **Sigma-Clip**. Each of these methods will improve your image by stacking it, but each one combines the images in different ways.

1. **Average** sums all the pixels and divides by the number of images chosen to combine.
2. **Sum** adds up all the pixels in the images. This will increase the **Max Pixel** value and the offset in the **Screen Stretch** window. If you **Sum** the image, the file should be saved as a fit in **IEEE Float** (beyond 16 bits) to preserve all the data in the image.
3. **Median** takes the middle pixel value from all of the images. The **Median** mode is useful when some pixels are extremely bright or dark (hot/dark pixels, cosmic ray hits). If Median mode is used, a **Normalize** option is available. **Normalize** will remove differences in the image scaling which could interfere with the median processing.
4. **Sigma-Clip** combines the best features of **Average** and **Median**. Sigma-Clip is the best choice for removing unwanted noise, hot pixels and satellite trails. It works like **Average** but also calculates the standard deviation of the averaged pixel values. The **Sigma Factor** will determine how many pixels from the standard deviation are discarded. The lower the **Sigma Factor**, the more pixels are discarded. 0.5 is a good value to start with.
   A new average is calculated without the discarded pixel. This value is assigned to the corresponding pixel in the output image.

**Filter**

Filtering an image is an operation that emphasizes certain characteristics of an image while suppressing others. MaxIm DL Essentials supports two kinds of filters: **Unsharp Mask** and **Gaussian Blur**. In the **Filter** window select which one of these filter types you would like to apply.

**Unsharp Mask** is a method of sharpening or high-pass filtering an image. It amounts to subtracting a low-pass filtered version of an image from itself. The low-pass filtered version is called the mask. The **Low-Pass Filter** itself can be set to **Mild** or **Strong** for different effect. Use **Mask Weight** to control the strength of the mask applied to the image. The **Mask Weight** is in percent; the higher the number, the stronger the mask.

**Gaussian Blur** is a method of blurring an image. It can be used to suppress noise in an image at the expense of sharpness. The **Radius** setting controls the amount of blurring applied to the image. Increasing the radius increases the amount of blur applied.

For best results, turn on the **Auto Full Screen** preview button, and adjust the settings. This allows you to rapidly adjust the settings until you are satisfied with the results. Then, click **OK** to actually apply the filter settings to the image.

It is best to use a light touch with this command, to avoid over-processing the image. Over-processing can create artifacts; i.e. features in the image that are not real. It also amplifies the noise in the image.

**Color Balance**

The sensitivity of most CCD cameras as a function of wavelength (color) is different from the response of the human eye. The filters used for creating color composites also have their own characteristics, as do the telescope optics. Although “perfect” color rendition is an elusive if not impossible goal (all individuals see colors slightly differently), it is straightforward to get “good” color balance with simple weightings. This is where the **Color Balance** command (in the **Process** menu, Figure 19) comes in handy to touch up the resultant colors in your images. Use the **Preview Image** to see how altering these parameters will affect your image (or click the **Full Screen** button to see the changes applied to your full image).

Color images from CCD cameras typically require a background level adjustment. This is accomplished by bringing the background level (or bias) in each color plane down to zero. Each of the **Background Level** values is subtracted from every image pixel in its color plane. Any pixel values that become negative are forced to zero. The **Auto** button automatically determines the settings...
necessary to equalize the image background in all three color planes. The **Reset** button resets the background level subtraction to zero on all planes.

**Scaling** adjustment (entered as a percentage) allows you to compensate for transmittance differences between the filters used to acquire the three color planes. Values of 100% result in no change. The **Scaling** percentages can be typed in or adjusted using the “spin” controls (small up and down click arrows to the right of the scaling numbers). The **Preview Image** is particularly helpful in monitoring the results when using the spin controls. The **Reset Scaling** button resets to 100% on all three planes.

The **Click On White Area to Set Scaling** check box enables the operation of the mouse to set the scaling. Set the **Background Level** first (you can use **Auto**), then click on a white object (e.g. a neutral-colored star) in the image (not the **Preview Image**) with the mouse. The **Scaling** settings will automatically be adjusted to make the selected point appear white. If an area of the image is known to be white (or gray), this is an easier way to determine the scaling factors, and can be used to instantly color balance the image.

**Stretch**

The **Stretch** command (located in the **Process** menu, Figure 20) modifies the brightness and contrast, and optionally the range (maximum and minimum pixel values) of an image. Unlike the screen stretch settings in the **Screen Stretch Window**, which only affects the how an image appears on the computer screen, the **Stretch** command actually changes the image data pixel values in the memory buffer. In reference to the histogram, the **Screen Stretch Window** changes how the histogram is displayed on the computer screen, the **Stretch** command alters the histogram itself.

There are three elements which must be set: the **Permanent Stretch Type**, the **Input Range**, and the **Output Range**. You can use the **Preview Image** to see how changing these parameters will affect the resultant image (or click the **Full Screen** button to see the changes applied to your actual image). You can also open the **Screen Stretch Window** to see how changing these parameters change the histogram.

For the **Permanent Stretch Type**, the **Linear Only** mode is useful for adjusting the range of pixels to match a particular file format. The **Log** mode is useful for compressing the dynamic range of the image, but can be rather harsh. The **Gamma** mode allows you to selectively emphasize bright or dim parts of the image by entering a suitable **Gamma Value**. A **Gamma** of 1 has no effect, less than 1 will emphasize faint details, while a value greater than 1 will emphasize bright details.

The **Input Range** can be set to **Screen Stretch**, which in **Linear Mode** produces an output matching the current screen appearance. This is useful in producing final images for output to 8-bit image formats which have limited range. Note that the minimum and maximum values are always taken from the screen stretch settings for the original image. These can be adjusted dynamically using, for example, **Quick Stretch**. The **Max Pixel** selection sets the input range from 0 to the brightest pixel in the image. This prevents any image pixels from being saturated in the final result, but may produce images with low contrast. You can also manually set values with **Manual Settings** in a similar fashion to the **Screen Stretch Window**.

The **Output Range** is used when preparing a file to be saved in a format that has limited range. The **Output Range** maps minimum input to zero, and maximum input to 255, 4095, or 65535 depending on the settings. Any values that exceed the limits are clipped. The **Unlimited** setting disables all limiting and is recommended when performing **Gamma** and **Log** stretches; it is appropriate when the image will be saved in floating point format.

**Recommended Processing Sequence**

What is the best order to apply the processing functions in? Here is a recommended sequence:

1. Calibrate (Dark Subtract and Flat Field calibrate)
2. Convert Raw to Color
3. Combine
4. Filter
5. Color Balance
6. Stretch

Once you have the combined image, you are free to continue processing the image as desired, or export it to a program like Photoshop. Be sure to **Save** a copy of the combined image; otherwise you might have to go back to the
beginning and stack individual images again!

**Note on File Format**
When saving images (using Save or Save As in the File menu), you have a choice of file formats. The default produces .fit files, but .tif, .jpg, .png, and .bmp file formats can also be selected. Having a choice of output file formats is useful, especially if images will be exported to other software programs for additional image processing (like Adobe Photoshop, for instance).

If you save to a file format other than .fit, you will need to check the Auto Stretch box, or otherwise Stretch the image to change the Output Range (in the Stretch command window) to match the Size Format (in the Save As window). Otherwise, the Output Range will likely exceed the Size Format, and the saved image will be ruined (will turn all white).

For example, say the Output Range is set to create image brightness values in 16-bit format, while the Size Format of a specific file format (.jpg, for example) may only support 8-bits. Since the 16-bit format sees 65535 brightness levels, and the 8-bit format can only support 255 levels, all of the levels above 255 in the 16-bit image (i.e. the vast majority of the 16-bit brightness levels) will be saved at the maximum 8-bit value of 255. So the saved .jpg will have very little brightness information from levels 1 to 254 and almost all the brightness information at level 255. Thus a white image results.

If you plan to do all image processing within MaxIm DL Essentials Edition (or the optional full version of MaxIm DL), saving images in the FITS (.fit) File Format using the IEEE Float Size Format is recommended. This ensures that all saved data will be kept intact. If another Size Format is utilized, there may be some loss of data, especially when saving combined images.

**Batch Process**
Batch Process can be used to process multiple images simultaneously using the various commands available in MaxIm DL Essentials Edition. It is especially useful when calibrating and converting each raw image to color. Select Batch Process from the Process menu (Figure 21).

Procedure for basic batch processing:

1. Select the image file you want to process from your computer using the Select Files button. Use CTRL-click to select individual files, and SHIFT-click to select a range of files. You can see the path for the selected files by turning on the Show Path check box. Or you can select images already open in MaxIm DL Essentials Edition by clicking the Select Images button. The window that pops-up will indicate all the images currently open.

2. Select the processing task you want done in the Processing Commands box. Choose up to 6 processing commands which will be executed in sequence.

3. Use the same recommended processing order for batch processing as you would normally do manually. You should 1. Calibrate, 2. Convert Raw To Color, etc.

You can remove selected images and files from the Batch Process list by selecting them with the mouse and clicking the Remove button.

4. Select the location for the saved files using the Path button, or click Write Output to Source Folder to cause the files to be saved back into the folder from which they were loaded. (This option cannot be used when an image has never been saved, for example, one freshly acquired from the camera.) In the event that saving a file will cause it to overwrite an existing file, you can select skip save, overwrite it, or move to subfolder. You can specify the subfolder name in the adjacent field. Use Size Format to select between 16-Bit Integer and 32-Bit IEEE Float formats for the processed images. To keep all processed image data intact (especially for stacked images), we recommend using the 32-Bit IEEE Float format. If you need to open the resultant files in another program, however, you may need to use the 16-Bit Integer format.

5. Click OK to start the Batch Process operation. Successfully converted and saved files are removed from the list box. If an error occurred the file will remain in the list. Point the mouse cursor at an image left in the list. The appropriate error message will appear in the Status Bar at the bottom of the MaxIm DL Essentials Edition main window.

**4. Using The StarShoot Pro as an Autoguider**

The StarShoot Pro can also be used as an autoguider instead of an imager. You can use the StarShoot Pro to autoguide a mount while images are being taken with another camera.

Tracking errors are usually sufficiently small on short exposure images (15 to 90 seconds depending on the mount) and do not require guiding. A series of unguided short exposure images can be taken and combined together using the Combine command. However, in many cases a single long exposure is...
superior due to the elimination of extra readout noise and the residual blurring caused in realigning the images.

When taking long exposures with astronomical telescopes, motorized tracking is required to compensate for the Earth’s rotation. Most telescope mounts do not track accurately enough for long-exposure imaging without some form of additional “guiding”. Manual guiding can be done by an observer watching a star (“guide star”) through a telescope (“guide scope”) mounted next to the main imaging telescope (on the same mount). The observer makes manual corrections to the motor drives via a pushbutton hand controller to keep the star centered in the guide scope’s eyepiece over time. In this way the tracking accuracy of the main telescope (with imaging camera attached) can be assured. Stars in the resultant images will be crisp and round. Manual guiding can be very tiresome and tedious, however, especially if taking many long exposures throughout the night.

The StarShoot Pro can be used as an “autoguider” to take the place of the observer so that no manual guiding corrections are needed during long exposure imaging. Keep in mind, however, that when the StarShoot Pro is used in this way, you will need another telescope and camera on the mount to actually take images with; the StarShoot Pro takes the place of the observer viewing through the guide scope, but cannot autoguide and image at the same time.

So, in order to use the StarShoot Pro as an autoguider, the following equipment will be required:

- Astronomical telescope mount capable of accepting autoguider drive commands.
- Cable to connect computer (serial port) to mount’s autoguider jack (mount specific).
- Main telescope for imaging.
- Camera for imaging.
- Guide scope for guiding.
- Any required rings or brackets for guide scope attachment to the mount along with the main telescope.

**Computer to Mount Connection**

In order for autoguiding with the StarShoot Pro to work, you need a way to send commands from the computer to the telescope mount. This is generally done with a cable connecting the computer’s serial (COM) port to the mount’s autoguider jack; this cable is generally mount specific, so contact the dealer you purchased your mount from for the proper cable for your mount.

If your telescope mount is supported by the ASCOM platform, it is a simple task to setup the autoguider to send commands (through the computer) to the telescope mount. To do this:

1. Insert the included CD-ROM into your computer.
2. When the Launcher appears (Figure 4), click on the Install ASCOM button and follow the automatic ASCOM platform installer instructions. Restart your computer as indicated when done.
3. Connect the StarShoot Pro to your computer and open the Maxim DL Essentials software.
4. In the Camera Control Window, click on the Guide tab (Figure 22).
5. Click on the Settings button.
6. In the window that pops-up (Figure 23), select ASCOM for the Autoguider Output Control Via. Click the Setup button under the Autoguider Output heading.
7. The ASCOM Telescope Chooser (Figure 24) will appear. Select your telescope model from the provided choices. If your model does not appear, it is not supported by the ASCOM platform.

8. After you have selected your telescope model, click the Properties button.

9. In the window that pops-up, choose your specific Scope Type and desired Serial Port where the computer will send commands to the mount. Click OK when done.

10. Click OK in the ASCOM Telescope Chooser window.

11. In the Settings window, click the Close button.

Some telescope mounts, such as the Orion Atlas EQ-G and Sirius EQ-G, utilize an “ST-4 compatible” autoguider jack. For easiest autoguiding with these mounts, we recommend purchasing the optional USB Guide Port interface (GPUSB). This adapter box will translate the autoguiding computer commands from MaxIm DL Essentials into ST-4 pulse commands. The GPUSB connects to the computer’s USB port instead of the COM port. A cable then connects the GPUSB to the mount. In addition to installing the ASCOM platform on your computer (from the Install ASCOM button in the Launcher), you will need to install the GPUSB ASCOM driver (downloadable from the Orion website, www.OrionTelescopes.com). Then, you can select the GPUSB in the ASCOM Telescope Chooser.

Other telescope mounts accept commands in the “LX200 Protocol”. For these mounts, it is not necessary to install the ASCOM platform to have the computer “talk” to the mount. To setup the autoguider for mounts that use the LX200 Protocol:

1. Connect the StarShoot Pro to your computer and open the Maxim DL Essentials software.
2. In the Camera Control Window, click on the Guide tab.
3. Click on the Settings button.
4. In the window that pops-up, select LX200 Protocol for the Autoguider Output Control Via. Select the COM Port of the computer you would like to use to send commands to the telescope.
5. Click the Apply button, then click the Close button.

**Autoguider Calibration**

In order to properly control the mount, you must calibrate the system. The exact orientation of the StarShoot Pro, the focal length of the guide telescope optics, and the speed of the motor drive all affect the calibration. To perform autoguider calibration:

1. Switch to the Guide tab.
2. Set the X and Y Aggr (aggressiveness) to 8 to start with. Set the Exposure to 1.0 second. Under Guide Star, make sure the Watch box is checked.
   *Note: The X and Y Aggr (aggressiveness) controls on the Guide tab allows you to adjust how vigorously star motions are tracked out in each axis. An aggressiveness setting of 10 means that the StarShoot Pro attempts to track out 100% of the motion, whereas a setting of 1 means that the StarShoot Pro only tracks out 10% of the motion. Usually a setting of around 8 or 9 provides the best tracking, since it reduces overshoot and helps ignore random motions due to atmospheric seeing and wind loads. You should experiment to determine the best setting for your particular telescope.*
3. Click the Settings button.
4. Maxim DL Essentials needs to know how fast the telescope moves in right ascension (R.A.) and declination (Dec.) when the autoguider commands are issued. To do this, the software will Calibrate the mount by moving it back and forth on each axis. The Calibration Time determines how long it activates the motors each time. The usual value is 5-10 seconds; start out with a value of 5.
5. Make sure all of the Guider Enables boxes are checked.
6. For Autoguider Output, set Control Via and COM Port as required for your telescope equipment. See “Computer to Mount Connection” if you have not already done this.
7. Click Apply. You can leave this dialog box open, or Close it if you wish.
8. Make sure that the telescope mount is set to move at 1X sidereal or slower. For some mounts, you must set the guide rate manually. The maximum usable rate is 1X sidereal. If your mount does not drift quickly, then 0.1X is recommended; otherwise use a value between 1X and 0.1X.
9. On the Guide tab, set to Expose, and click the Start button. A single image will be taken. Ensure that a well-focused bright star (near the actual object to be imaged) appears in the image. If not, adjust the guide scope and try again. Make sure the star is roughly centered.
   *Note: The algorithm can be confused if another star appears in the frame; to minimize this risk, calibrate on an isolated bright star.*
10. Now, set to Calibrate, and click the Start button. A series of five exposures will be taken; each time the telescope will be moved slightly. If the
11. The star should move in an L shape. If it does not move enough, a warning message will appear. The recorded positions will be displayed in the scrolling log, along with any error messages.

**Note:** If the star does not move far enough, or moves too far (i.e. the star leaves the field), the duration of the calibration move commands can be adjusted by clicking the **Settings** command and changing the **Calibration Time** fields (measured in seconds). A longer calibration time will increase the motion of the star; a shorter time will decrease the motion. Typical values range from five to ten seconds, depending on the correction speed, focal length, and pixel size.

12. Once you have successfully calibrated, switch to the **Track** mode. Click **Start**, and watch the star. It should move to the center of the small track box, and whenever it drifts off it should be pulled back again. You can zoom in the window for a better look. Also the tracking errors will be displayed in the scrolling log.

13. If the star bounces back and forth, reduce the aggressiveness for that axis. If it corrects too slowly, increase the aggressiveness. Changes to the aggressiveness settings take effect immediately.

You are now ready to take a long-exposure image through the main telescope and imaging camera. The StarShoot Pro will continuously send small correction factors to the mount's motor drive to insure steady and accurate tracking throughout the duration of the exposure, however long that may be.

**Other Autoguiding Notes:**

- If you are using a German equatorial mount you must calibrate with the tube on the same side of the mount as it will be when actually imaging.

- The calibration settings need changing if you move the telescope in declination by more than about five degrees. Select another bright star, and Calibrate again.

- If you experience bad guiding in declination and cannot resolve it through adjusting the calibration or aggressiveness, you may have a stiction problem with your declination drive. Watch which way the star drifts, and turn off the Guider Enable checkbox (in the Settings window) that pushes the star in that direction. That will prevent the stiction cycle from happening.

- Make sure that any backlash compensation in the mount is turned off.

- On most telescopes, the Right Ascension drive likes to have some load pushing against sidereal tracking. If the mount is balanced such that it is pulling the mount forwards slightly, the gear teeth may bounce back and forth resulting in terrible guiding that cannot be corrected by an autoguider. Be sure to always balance the telescope such that it “lifting the weight” rather than “allowing it to fall”; i.e. heavier on the East side. Note that this may require balancing the telescope differently when it is pointed East versus West.

### Multiple Camera Control for Autoguiding

One very nice feature of the Maxim DL Essentials software is the ability to control two cameras simultaneously. This way, you only need one computer and software program to image and autoguide at the same time. This feature is also compatible with older SSDSI cameras.

1. Plug both cameras, one at a time, into the USB ports on your computer. Install the drivers for each camera as detailed prior in this instruction manual.

2. Open the Maxim DL Essentials software. In the **Camera Control Window** that appears, you will notice the **Cam 1** and **Cam 2** selection circles are now active in the **Expose** tab.

3. Choose which camera you would like to image with by clicking on the appropriate selection circle. You may want to take a short test exposure with each camera just to make sure everything is working OK.

4. Click on the **Guide** tab. You will again see the **Cam 1** and **Cam 2** selection circles, and the camera not currently selected for imaging (in the Expose tab) should be automatically selected for autoguiding.

### 5. Other Features of Maxim DL Essentials

#### Edit Menu

- **Flip** – Flips image orientation. “Folds” image about vertical center.
- **Mirror** – Creates mirror image of current image orientation.
- **Crop** – Lets you select an area of the total image, and then discards the remainder of the image. Use your computer's mouse and left-click button to select the region of the image you wish to keep, and click the OK button to discard the rest of the image.
- **Undo/Redo** – Lets you step “backward” and “forward” during image processing. If you perform a function improperly or do not like the results, you can select Undo to return the image to its prior appearance. Redo performs the “undone” function once again.
**View Menu**

**Zoom** – Increases or decreases level of image magnification on computer screen. When you zoom in too much, you will start to see the squares of individual pixels. When zoomed in, you can use **Quick Pan**; simply hold down the Ctrl key, then left-click and drag the mouse on the image.

**Night Vision** – Toggles Night Vision mode. The red background helps preserve your night vision.

**FITS Header Window** – The FITS Header Window can be used to inspect the image FITS header, which stores information about the image. FITS is the standard storage format for astronomical images. The window can remain open as a floating toolbox without interfering with other commands. If several images are opened at once, you can view the FITS header of each image by clicking on it with the mouse. Note that if you make changes to the image, they are not reflected in the viewer until the image is saved.

**Toolbar** – Selecting this creates a toolbar of “quick command” buttons at the top of the MaxIm DL Essentials program window. This can be a handy way to perform functions, especially when in the field and wearing gloves!

**Status Bar** – displays information on the current operation (when highlighted in its selection menu but not actually selected yet), the contrast ratio for the selected open image, the size of the currently selected image, the zoom factor, the coordinates of the mouse on the image, the intensity of the pixel under the cursor, and for color images, the red, green, and blue intensities of the pixel under the cursor.

**Window Menu**

**New Window** – This creates a second view of the currently selected image. The new view can be independently panned and zoomed, but will have the same stretch as the original window.

**Fit to Image** – This toggles the Fit to Image mode on and off. The Fit to Image mode causes the window for the image to be adjusted to the same size as the image. If the view is zoomed out, the window will shrink with it. If the view is zoomed in, the window will grow until it fills the main window.

**Cascade, Tile Horizontally, Tile Vertically** – These functions alter the way multiple open image frames are arranged and displayed within MaxIm DL Essentials Edition. These functions are very useful for organizing the visual display when processing large numbers of raw images for stacking.

**Restore All** – This command will restore all minimized image windows to the position they had within the MaxIm DL application window at the time they were minimized. This can be handy for sorting images. For example, when inspecting a set of images, you can close the ones you want to reject, and minimize the ones you want to keep. Once all the images have been reviewed you can restore the minimized windows to their original size and position.

**Arrange Icons** – Image windows can be minimized, at which point they become small bars (icons). If these have become scattered about the main application window, the **Arrange Icons** command will stack them neatly at the bottom of the window.

**Help Menu**

**Help Topics** – Click on this if you have any questions. This is an extensive resource, and should be consulted often. Under the **Index** tab, type in “Help Topics” and press Enter on your keyboard. This will give a primer on how to most effectively use and access the Help files.

**About MaxIm DL** – Gives the version number of the software.

*Note: The Open or Convert AVI File command in the File menu is for the StarShoot Solar System Imager, not he StarShoot Pro.*

### 6. Tips

**Polar Alignment**

Good telescope mount polar alignment is of critical importance for long-exposure CCD imaging. Inaccurate polar alignment leads to image movement over time (even with motor drives running and engaged), which limits the amount of time an exposure can be taken before the stars begin to streak and blur.

If your equatorial mount uses a polar axis finder scope, we highly recommend utilizing it for polar alignment. If not, a technique known as the “drift method” of polar alignment has been used for many years, and can achieve an extremely accurate polar alignment. Unfortunately it is very time consuming, since the drift of a star over time must be observed. The basic idea is to let the telescope mount track while watching a star to see which way the star drifts. Note the direction of the drift, and correct by moving the mount in the appropriate direction.

To perform the drift method of polar alignment:

1. Do a rough polar alignment by pointing the R.A. axis of the mount at Polaris (the North Star).
2. Find a bright star near the meridian (the imaginary line running north-to-south through zenith) and near the celestial equator (zero degrees declination). Point the telescope at this star, and center it in an illuminated reticle eyepiece (available from Orion). If you don’t have an illuminated reticle eyepiece, use your highest-magnification eyepiece.
3. Determine which way is north and south in the eyepiece by moving the telescope tube slightly north and south.
4. Now, let the mount’s motor drive run for about five minutes. The star will begin to drift north or south. Ignore any east-to-west movement.
5. If the star drifts north, the telescope mount is pointing too far west. If the star drifts south, the telescope mount is pointing too far east. Determine which way the star drifted and make the appropriate correction to the azimuth position of the mount. Rotate the entire mount (and tripod) slightly east or west as needed or use the azimuth adjustment knobs (if your mount has them) to make fine adjustments to the mount's position.

6. Next, point the telescope at a bright star near the eastern horizon and near the celestial equator (Dec. = 0).

7. Let the telescope track for at least five minutes, and the star should begin to drift north or south.

8. If the star drifts south, the telescope mount is pointed too low. If the star drifts north the telescope mount is pointed too high. Observe the drift and make the appropriate correction to the mount's altitude (or latitude); most mounts have some sort of fine adjustment for this.

Repeat the entire procedure until the star does not drift significantly north or south in the eyepiece. When this is accomplished, you are very accurately polar aligned, and should be able to produce good (unguided) images of up to several minutes long, assuming the mount's drives track well with little periodic error.

Choosing a Site for Astro-imaging
Once you have a focused image, you may find your image shifting and washed out. This can be caused by many environmental factors. Poor seeing (movement of molecules in the air, such as heat rising) and poor transparency (moisture, smoke, or other sky contaminants) will all serve to reduce image quality. That is why most major astronomical telescopes are on high mountains in thin air, to get above much of the transparency and seeing problems. Also, wind will move your telescope and affect images. Your eyes viewing through an eyepiece can change slightly to compensate for disturbances like these, but the camera can not. Keep these factors in mind when choosing an observing site for astronomical imaging.

For the best astro-images, we recommend finding a location with dry air, some altitude, and away from city or streetlights. Even a nearby hilltop in the countryside can provide better viewing conditions than many convenient backyard locations.

Using Focal Reducers and Barlow Lenses
Focal reducers and barlow lenses change the effective focal length of a telescope. These lenses are inserted between the camera and telescope when imaging to change image scale.

Focal reducers serve to decrease the focal length of your telescope. This increases the field of view seen by the camera (decreases camera magnification). This can be very useful for obtaining images of wide-field deep sky objects, such as the Andromeda Galaxy or the Pleiades star cluster. Focal reducers will usually thread onto the nosepiece of the StarShoot Pro.

Barlow lenses increase the focal length of your telescope, which makes the camera's field of view narrower (increases camera magnification). This is useful for planetary imaging. Keep in mind that when the focal length is doubled, the image will become four times dimmer, so a longer exposure may be necessary. Barlow lenses are generally inserted in the focuser's drawtube and secured with the thumbscrew on the focuser's drawtube, and the StarShoot Pro's nosepiece is inserted into the barlow and secured with the thumbscrew on the barlow lens.

Filters
Any standard Orion 2" filter will thread into the 2" nosepiece of the StarShoot Pro. Light pollution filters, or special light pollution filters designed for imaging (such as the Orion SkyGlow Imaging Filter) improves image contrast from urban areas with severe light pollution.

USB Extension Cable
Most imaging setups may require extra distance to comfortably reach from StarShoot Pro to the computer. We recommend purchasing a 10' USB extension cable if you need more cord length (available through Orion, check the catalog and/or www.OrionTelescopes.com).

Care and Maintenance
When the StarShoot Pro is not in use, the dust cap should be replaced on the end of the nosepiece. This prevents dust from accumulating on the StarShoot Pro's optical window. If significant dust does accumulate on the optical window, or the optical surface is touched, then it should be cleaned.

Any quality optical lens cleaning tissue and optical lens cleaning fluid specifically designed for multi-coated optics can be used to clean the glass surface of the StarShoot Pro's optical window. Never use regular glass cleaner or cleaning fluid designed for eyeglasses.

Before cleaning with fluid and tissue, blow any loose particles off the surface with a blower bulb or compressed air. Then apply some cleaning fluid to a tissue, never directly on the optics. Wipe the optical surface gently in a circular motion, then remove any excess fluid with a fresh lens tissue. Oily fingerprints and smudges may be removed using this method. Use caution; rubbing too hard may cause scratches.

Store the StarShoot Pro in the included hard carrying case. Keep the camera in a dry location away from direct sunlight.
7. Specifications

**CCD Sensor:** Sony® SuperHAD™ ICX413AQ Color
**Sensor format:** 1.8"
**Pixel array:** 3032x2016 (6,112,512 total)
**Pixel size:** 7.8µm x 7.8µm
**Exposure range:** 0.002 seconds to 9.3 hours
**A/D conversion:** 16 bit
**Binning:** optional 2x2
**Thermoelectric cooling:** 30°C (54° F) below ambient temperature, sealed dry air chamber to prevent CCD icing
**Operating Power Range:** 8VDC to 13.8VDC
**Camera current draw:** Approximately 1A (at 12VDC)
**USB connection:** 2.0 High speed
**IR-cut filter:** Yes
**Optical window:** Fully coated with anti-reflection coatings
**Weight:** 28 oz.
**Autoguider capability:** Yes
**Mounting:** 2" nosepiece or T-thread

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Changes of modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an output on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

A shielded cable must be used when connecting a peripheral to the serial ports.

Appendix A. Troubleshooting

Camera is not recognized when plugged into the computer’s USB port or there is no USB chime with a “Found New Hardware Wizard”.

Make sure your computer has a high-speed USB 2.0 port available.

The camera will not work if you are using USB 1.1. Normally Windows will display a warning message when the camera is plugged into a USB 1.1 port, but the computer may also fail to recognize the camera entirely. Older laptop computers can be upgraded to USB 2.0 with a PCMCIA card.

Use the supplied USB cable first.

Extension USB cables (available from Orion) should work with the camera. But adding length and another connection point between the computer and camera can potentially cause problems. If you are using an extension cable, limit the cable length to 10’. The total cable length including the original cable should be 20’ or less.

Make sure the camera is properly powered with a 12VDC power source.

The camera will only function when both the USB cable and power cable are plugged in. The cooling fan should immediately start once the camera is properly powered on and plugged into the computer.

The camera hardware and drivers installed, but a message appeared indicating the device might not work properly.

Make sure there are no other USB devices running when you install the StarShoot Pro.

Try rebooting the computer and reinstalling the camera on a different USB port.

Try operating the camera in MaxIm DL Essentials.

Sometimes the camera may function without problems after the install error message.
Check your USB connection for anything that could potentially introduce interference.

Large power supplies or even a cellular phone near the camera or USB cable could interfere with the data as it is uploaded from the camera to the computer. If you are using a USB extension cable, keep the total length between the camera and computer to 20’ or less.

The images look very noisy overall.

Take a 15 second dark frame and inspect the image data.

Position the mouse cursor over a dark part of the image. The Max Pixel should be somewhere between 500 and 5000. If the Max Pixel value is significantly higher than 5000, please consult Orion’s Customer Service.

The camera lost its connection.

Attempt to re-establish the connection.

The camera can lose connection for several reasons; if a cable becomes unplugged, the computer “freezes”, or the software/hardware otherwise temporarily loses the data coming from the camera. To re-establish camera connection, first close the Maxim DL Essentials program on your computer. Then, unplug and re-plug the camera into the computer’s USB port. Open Maxim DL Essentials, and the Camera Control Window should appear indicating re-established connection between camera and computer.

If you are unable to resolve your problem with the information provided here, please contact Orion’s Customer Service at 800-676-1343 or email support@telescope.com.

The “Found New Hardware Wizard” appears again when the camera is plugged into a different USB port for the first time.

This is normal.

Most USB controllers behave this way. Every time the camera is plugged into a different USB port for the first time, the drivers will have to be reinstalled. Since the drivers were previously installed on your computer, you do not need the CD when installing the camera on a new USB port.

Note that external USB hubs will behave the same way.

Every time the camera is plugged into a different USB port on the hub, the “Found New Hardware Wizard” will appear again.

Windows Vista should automatically install the drivers on different USB ports without prompting you to take any action.

There are several short horizontal lines or there is irregular noise throughout the image.

You are likely experiencing readout noise as a result of running the camera too fast for your computer (Figure 25).

The camera has 8 speed settings, listed 1-8 (default is 5). The higher the speed setting, the faster the image will download. Higher speed settings require faster processors.

If you do not see any short horizontal lines in your images, you can try increasing the readout speed one or two points. To make an adjustment, click on Setup in the Camera Control Window. Click the up/down arrows to change the speed setting (Figure 26). The minimum is 1; the maximum is 8.
## Appendix B. Field of View Quick Reference Guide

For your convenience, refer to the list of common telescope focal lengths and their corresponding fields of view provided by the StarShoot Pro. The angular field of view is shown in arc-minutes. The image scale shows the relative size of two reference objects; the Moon and the Orion Nebula.

<table>
<thead>
<tr>
<th>Telescope Focal Length</th>
<th>Angular Field of View</th>
<th>Image Scale of the Moon</th>
<th>Image Scale of M42</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 mm</td>
<td>208.2' X 135.9'</td>
<td><img src="image1.png" alt="Moon Image" /></td>
<td><img src="image2.png" alt="M42 Image" /></td>
</tr>
<tr>
<td>500 mm</td>
<td>166.6' X 108.7'</td>
<td><img src="image3.png" alt="Moon Image" /></td>
<td><img src="image4.png" alt="M42 Image" /></td>
</tr>
<tr>
<td>600 mm</td>
<td>138.8' X 90.6'</td>
<td><img src="image5.png" alt="Moon Image" /></td>
<td><img src="image6.png" alt="M42 Image" /></td>
</tr>
<tr>
<td>750 mm</td>
<td>111' X 72.5'</td>
<td><img src="image7.png" alt="Moon Image" /></td>
<td><img src="image8.png" alt="M42 Image" /></td>
</tr>
<tr>
<td>900 mm</td>
<td>92.5' X 60.4'</td>
<td><img src="image9.png" alt="Moon Image" /></td>
<td><img src="image10.png" alt="M42 Image" /></td>
</tr>
<tr>
<td>Telescope Focal Length</td>
<td>Angular Field of View</td>
<td>Image Scale of the Moon</td>
<td>Image Scale of M42</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------</td>
<td>-------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>1000mm</td>
<td>83.3' X 54.4'</td>
<td><img src="image1" alt="Image of the Moon" /></td>
<td><img src="image2" alt="Image of M42" /></td>
</tr>
<tr>
<td>1250mm</td>
<td>66.6' X 43.5'</td>
<td><img src="image3" alt="Image of the Moon" /></td>
<td><img src="image4" alt="Image of M42" /></td>
</tr>
<tr>
<td>1800mm</td>
<td>46.3' X 30.2'</td>
<td><img src="image5" alt="Image of the Moon" /></td>
<td><img src="image6" alt="Image of M42" /></td>
</tr>
<tr>
<td>2032mm</td>
<td>41' X 26.8'</td>
<td><img src="image7" alt="Image of the Moon" /></td>
<td><img src="image8" alt="Image of M42" /></td>
</tr>
<tr>
<td>2540mm</td>
<td>32.8' X 21.4'</td>
<td><img src="image9" alt="Image of the Moon" /></td>
<td><img src="image10" alt="Image of M42" /></td>
</tr>
<tr>
<td>2800mm</td>
<td>29.7' X 19.4'</td>
<td><img src="image11" alt="Image of the Moon" /></td>
<td><img src="image12" alt="Image of M42" /></td>
</tr>
</tbody>
</table>
### Appendix C.
### Summarized Procedure to Imaging Deep Sky Objects

<table>
<thead>
<tr>
<th>Action</th>
<th>Process Tree</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Image Capture</strong></td>
<td></td>
</tr>
</tbody>
</table>
| 1. Focus on a moderately bright star at least 30° (or more above the horizon). | Camera Control Window, Mode → Light Color 1x1, Single → Expose (approx 1 second)  
Draw a subframe around the star to focus on  
Camera Control Window, Mode → Light Color 1x1, Single → Expose (fraction of a second)  
Focus on the star.  
Camera Control Window, Subframe → Reset                                  |
| 2. Acquire and center the deep sky object you want to image. Autosave as many images as you would like (5 or more images is recommended to later combine). | Take some single exposures to ensure the object focus, centering, and orientation are correct.  
Camera Control Window, Mode → Light Color 1x1, Single → Expose (X # of seconds)  
Begin capturing and saving the deep sky images. For best results, choose Light Raw 1x1.  
Camera Control Window, Mode → Light Raw 1x1, Autosave (X # of images) → Expose (X # of seconds) |
| 3. Take a dark frame right before or after you capture the deep space object. | Camera Control Window, Mode → Dark Raw 1x1, Autosave (3-10 images)  
Cover telescope objective.  
Camera Control Window → Expose                                                                 |

<table>
<thead>
<tr>
<th>Telescope Focal Length</th>
<th>Angular Field of View</th>
<th>Image Scale of the Moon</th>
<th>Image Scale of M42</th>
</tr>
</thead>
<tbody>
<tr>
<td>3000mm</td>
<td>27.8’ X 18.1</td>
<td><img src="image1.png" alt="Image Scale of the Moon" /></td>
<td><img src="image2.png" alt="Image Scale of M42" /></td>
</tr>
<tr>
<td>3910mm</td>
<td>21.3’ X 13.9’</td>
<td><img src="image3.png" alt="Image Scale of the Moon" /></td>
<td><img src="image4.png" alt="Image Scale of M42" /></td>
</tr>
<tr>
<td>Action</td>
<td>Process Tree</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Take a flat field image by pointing the telescope at a uniform and featureless light source, like the sky at dawn or a white sheet of paper. Find the right exposure time that creates a <code>Max Pixel</code> value of approximately 20000, then proceed to Autosave your flats.</td>
<td>Find the exposure which creates a <code>Max Pixel</code> of about 20000.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Camera Control Window, Mode → Light Raw 1x1, Single → Expose</em> (0.1 seconds or so)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Begin taking and autosaving the flat field images.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Camera Control Window, Mode → Light Raw 1x1, Autosave (5-10 images) → Expose</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td>You do not have to take your flat fields before you start imaging. They can be taken before or after your astro-images during the day, or any time you have a suitable light source.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Image Processing**

<table>
<thead>
<tr>
<th>1. Calibrate darks and flats</th>
<th>Select your darks and flats.</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Process → Setup Calibrate → Add</em> your dark frames, flat fields, and dark frames for flat fields → <strong>OK</strong></td>
<td></td>
</tr>
<tr>
<td><em>Now calibrate your astro images.</em></td>
<td></td>
</tr>
<tr>
<td><em>File → Open → select the astro images you want to open → Open</em></td>
<td></td>
</tr>
<tr>
<td><em>Process → Calibrate</em></td>
<td></td>
</tr>
<tr>
<td>2. Convert raw to color</td>
<td><em>Process → Convert Raw to Color, Camera Type → StarShoot Pro High Quality → OK</em></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>3. Combine the images</th>
<th><em>Process → Combine → Select all of the open images you want to combine → OK</em></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>Combine Images window, Align Mode → Manual 1 star – shift only/Manual 2 stars</em></td>
</tr>
<tr>
<td></td>
<td>Use the mouse cursor to select the alignment star(s) in each image</td>
</tr>
<tr>
<td></td>
<td><em>Combine Images window, Output → Average → OK</em></td>
</tr>
<tr>
<td></td>
<td>Various processing commands are found in the <em>Process</em> menu.</td>
</tr>
<tr>
<td>4. Make other adjustments if needed, such as stretch, filter, or color balance. See “Image Processing”.</td>
<td></td>
</tr>
<tr>
<td>5. Export and save in fits format to keep all of the image data.</td>
<td><em>File → Save As, File Filter → FITS Images, Size Format → IEEE Float → Save</em></td>
</tr>
</tbody>
</table>
One-Year Limited Warranty

This Orion StarShoot Pro is warranted against defects in materials or workmanship for a period of one year from the date of purchase. This warranty is for the benefit of the original retail purchaser only. During this warranty period Orion Telescopes & Binoculars will repair or replace, at Orion's option, any warranted instrument that proves to be defective, provided it is returned postage paid to: Orion Warranty Repair, 89 Hangar Way, Watsonville, CA 95076. If the product is not registered, proof of purchase (such as a copy of the original invoice) is required.

This warranty does not apply if, in Orion’s judgment, the instrument has been abused, mishandled, or modified, nor does it apply to normal wear and tear. This warranty gives you specific legal rights, and you may also have other rights, which vary from state to state. For further warranty service information, contact: Customer Service Department, Orion Telescopes & Binoculars, 89 Hangar Way, Watsonville, CA 95076; (800) 676-1343.